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Introduction 
This Resource Guide: How to Use the Technical Report Template explains how to prepare 
technical reports using the NYSERDA Report Template. It provides the document structure and 
formatting guidelines to use when creating a report for the New York State Energy Research and 
Development Authority (NYSERDA). 

Read this guide to learn how to obtain the correct template for a NYSERDA report, how to set 
up helpful MS Word document formatting options, and how to use the template features to 
produce high-quality, consistent and accessible reports for NYSERDA. 

Note: For experienced template users, there is quick reference list of requirements on the 
following page. (“Quick Checklist for Report Writers & Preparers”). For those without template 
experience, follow this guide. 

About the NYSERDA Report Template 
The NYSERDA report template is a MS Word document shell that contains a set of pre-formatted 
content elements.. The template enables reports to be created with consistent design, layout, 
and formatting features that include styles, text, headers and footers, tables, and more.  

Note: MS Word 2013 or later is required. 

Downloading the NYSERDA Report Template 
Download the template. Save it to the same computer where you plan to create the report 
document (e.g., local computer, network directory folder, virtual computer, OneDrive, etc.). 

Template Use Template File Name Download Location 
Research and Technical 
Reports 

NYSERDA Technical Report Template V1 
(2026).dotx 

nyserda.ny.gov/Doing-
Business-with-NYSERDA/ 
NYSERDA_Technical_Repor
t_Template_V1_(2026).dotx 

 

http://nyserda.ny.gov/resources/
http://nyserda.ny.gov/resources/
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Quick Checklist for Report Writers and Preparers  
Use this checklist to ensure the report has the correct components and to ensure the report is 
clear, consistent, and accessible  

Front Matter 
☐ Include title page (authors, affiliations, dates, report ID). 
☐ Add Record of Revisions (if required). 
☐ Include Abstract. 
☐ Include Keywords. 
☐ Include Acknowledgments (if desired). 
☐ Include Preferred Citation. 
☐ Compile a complete Acronyms and Abbreviations list. 

Body Matter (Main Text) 
☐ Include Summary or Executive Summary. 
☐ Apply template formatting using Styles, maintain heading hierarchy (H1, H2, H3, etc.). 
☐ Spell out all abbreviations and acronyms on first use, use abbreviations and  

acronyms consistently. 
☐ Tables, Figures, and Images 
 Reference each table, figure, and image in the text. 
 Create tables in Word or Excel; avoid merged cells and multiple header rows. 
 Number all tables and figures sequentially (avoid multiple images in one figure, labeling 

a, b, c, etc.). 
 Shorten long titles by moving explanatory text to captions. 
 Ensure figures and images are hi-res (300 dpi+). 
 Include source credits, if needed (author-date). 

☐ Number equations, examples, and case studies consistently. 
☐ Cite all sources consistently using author-date (Chicago) style.  
☐ Verify units, data, and statistics for accuracy, internal consistency, and correct citation. 
☐ Citations: Footnotes should be used sparingly and only for brief information.  

Consistency & Technical Terms 
☐ Use consistent word choices (avoid multiple terms for the same concept). 
☐ Standardize style (hyphenation, capitalization, abbreviations, units). 
☐ Avoid jargon and gendered language. 
☐ Verify all cross-references (e.g., “See Section 4.2”). 
☐ Use global search/replace to check consistency. 
☐ Check grammar and punctuation throughout for clarity and professionalism. 
☐ Ensure paragraph structure supports readability (clear sentences, logical flow, avoid  

overly long sentences). 
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☐ Review for plain language and readability. 
☐ Confirm consistent use of tense, voice, and number style. 

Back Matter 
☐ Include only cited works in References; place all other materials in Secondary References. 
☐ Alphabetize the reference list by author; for multiple words by the same author, list them 

from earliest to latest. 
☐ Verify URLs and DOIs; add access dates. 
☐ Label appendices clearly (Appendix A, B, …) and update cross-references. 
☐ Previously published material should be unchanged from previous publication. Include as 

added pages in the pdf. 
☐ Consult the sample report if unsure about the formatting of references. 

Final Pre-Submission Steps 
☐ Run Microsoft Editor for spelling and grammar. Use “Document stats” to review/reduce 

passive sentences.  
☐ Run Accessibility Checker (Click “Review,” “Check Accessibility”). 
☐ Ensure color contrast meets accessibility standards. 
☐ Use noncolor cues in figures that rely on color (labels, patterns). 
☐ Remove comments, tracked changes, and placeholder text. 
☐ Ensure that all endnotes/footnotes include descriptive text to accompany a URL. 
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Getting Started 
This section explains how to start a new report document and how to customize your  
MS Word Options settings. Customizing settings first makes report prep easier. 

Starting a New Report 
Start a new NYSERDA report document based on the applicable NYSERDA report template file 
(see “Downloading the NYSERDA Report Template”).  

The report template file ends with a “.dotx” file extension, which indicates it’s a template. 
Double-click the template file to start a new document based on the selected template. 

Immediately save the new document using established report file naming conventions. 

Updating a Report from a Previous Year 
If the report is an update from a previous year, either use the version in your archive or if 
produced by NYSERDA Marketing, request the most recent version. 

Setting Microsoft Word Options 
This section explains how to set certain MS Word options to the recommended settings for 
high-quality reports. MS Word Options provide a variety of settings to help improve the report 
writing experience when using templates. The Word Options menu has a group of settings that 
control features such as Autocorrect, Save, Proofing, and Document Accessibility. These features 
can impact the usability of templates and therefore, it’s important to review these options and 
adjust if needed before starting work on a NYSERDA report or when applying a NYSERDA report 
template to an existing document. 

Note: Some MS Word settings apply on a per-document basis and may need to be set for each 
document. 

Display Options 
In addition to default options already selected, you can select the following settings to help view 
hidden formatting when working on documents in MS Word. If desired, change the following 
optional Display settings on the Word Options screen. 
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1. Select File > Options > Display. 

○ Object anchors: (OPTIONAL) Displays a small anchor icon in the document margin  
to show which paragraph a floating picture, text box, or table is attached to. This 
helps by showing if an item on a page has been locked to make sure it stays close  
to specific text. 

○ Show all formatting marks: (OPTIONAL) Allows you to permanently display non-
printing characters—such as spaces, tab marks, and paragraph marks—regardless  
of whether the "Show/Hide" button on the Home tab is turned on. This option  
helps to provide better control over document layout. 

 

Autoformatting Options 
MS Word’s autoformatting settings can conflict with the styles set up in the NYSERDA  
report template. Change the following Proofing settings on the Word Options screen. 

1. Select File > Options > Proofing. 

1. Click AutoCorrect Options. 
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2. On the AutoFormat tab, ensure only the following settings are checked: 

○ “Straight quotes” with “smart quotes” 

○ Hyphens (--) with dash (—)  

○ Bold* and _italic_ with real formatting 

○ Internet and network paths with hyperlinks 

○ Styles 

○ Plain text e-mail documents 

 

3. On the AutoFormat As You Type tab, ensure ONLY the following settings are checked 
and clear the other options on this tab if they are currently checked. 

○ “Straight quotes” with “smart quotes” 

○ Hyphens (--) with dash (—)  

○ Internet and network paths with hyperlinks 
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Save Options 
1. Select File > Options > Save. 

The Word Options dialog box displays. 

2. Select the following options: 

○ Embed fonts 

○ Embed only the characters used in the document (best for reducing file size) 

 

3. Click Advanced. 

4. Under the Image Size and Quality area, click Do not compress images in files. 

Note: This setting stops image compression, which can help keep graphics looking better. 
However, if you already saved a document with image compression, changing these settings 
won't reverse the compression. In this situation, you would need to choose this setting and then 
re-paste the image(s) into the document. 

 

Document Accessibility Options 
The NYSERDA Report Template was designed with Section 508 Accessibility compliance 
guidelines in mind. The template layout, choice of text fonts, colors, and style settings use best 
practices to support many accessibility features. However, it’s important to be aware of some 
common best practices to make reports more accessible: 

• Use the Accessibility Checker tool in MS Word to analyze the report content for possible 
accessibility issues. On the MS Ribbon, click the Review > Check Accessibility to run the 
tool. Note: This tool does not check for all accessibility issues. 

• Use the headings and styles that come with the template to organize your content in a 
way that makes sense. 

• Write sentences in clear and easy to understand language when possible. 
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• Ensure figure text is legible and that the font point size is no smaller than 8 pts. 

• Add alternative text (Alt Text) to images, figures and tables. 

• Create simple tables that do not have merged cells or multiple table header rows. 

• Refrain from using color as the only way to convey meaning when creating tables or 
figures. 

• Review the Accessibility Options under File > Options > Accessibility to understand what 
Accessibility features are available in MS Word. 

Note: Uncheck the “Automatically generate alt text for me” option in the Word options dialog 
box to avoid misleading alternative text. When “Automatically generate alt text for me” is 
selected, MS Word adds generic descriptions for each figure that are rarely accurate, and are not 
helpful or meaningful to people who rely on screen readers to understand the information. 
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Advanced Document Properties 
When starting a new report or applying a NYSERDA report template to an existing document, 
ensure the following document properties are updated to follow Section 508 Accessibility best 
practices—Title, Subject, Company, and Author. 

To update the document properties: 

1. From the MS Word Ribbon Menu, click File > Info > Properties > Show All Properties.  

The Properties section displays. 

 

2. Complete the following properties and then save the document: 

○ Title: Type the Report Title. 

○ Subject: Type the main subject of the report. 

○ Company: Type your organization’s name, depending on the terms of your contract. 

○ Author: NYSERDA 

https://www.section508.gov/create/documents/
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Report Outline Structure 
This section lists the required and recommended sections of a NYSERDA report organized by the 
order they show in the template. See also the “Quick Checklist for Report Writers and Preparers” 
on page 2 for more details about what is required in a report being prepared for NYSERDA. 

Note: The NYSERDA Report Template uses numbered headings for its main and sub-level topics. 

Front Matter 
• Record of Revision (when required) 

• Title page 

• Notice 

• Preferred Citation (optional) 

• Abstract (required for accessibility and searchability). 

• Keywords (required for searchability). 

• Acknowledgments (optional). 

• Table of Contents (required; use the existing automated Table of Contents in the 
NYSERDA Report Template.) 

• List of Figures (required if three or more figures [e.g., charts, photos, diagrams, etc.]  
are used) 

• List of Tables (required if three or more tables are used) 

• Abbreviations and Acronyms (required) 

• Definitions (optional) 

Report Body 
• Executive Summary or Summary 

• Main Report Body 

• References Cited and Bibliography information 

Back Matter 
• Appendices (optional) 
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Other Report Elements 
• Copyright information for intellectual property (i.e., images, figures, tables or large  

pieces of text that have been previously published)—include written permission from  
the copyright holder at the end of the document and use appropriate language in the 
captions of the images, figures and tables such as “Reprinted with permission from 
[publisher’s name].” 

• Alternative text that describes each image and figure (include Alt text for tables that are 
included as images)—and does not just repeat the title or caption. The alt text may be 
inserted into the document using the Alt text panel or provided in a separate file. (See 
Appendix C, “Best Practices to Make Word Documents Accessible” for more information.) 



 

12 

Understanding Template Styles 
You can easily change the appearance of text, tables, and lists in your document by applying a 
style, which is a group of content formatting properties. Applying styles helps to structure 
content while maintaining consistency when working on lengthy reports. Styles also support the 
Table of Contents and contribute to document accessibility. 

The NYSERDA Report Template uses a collection of pre-defined MS Word Styles to control how 
the report content should look. The following broad categories of styles are used: 

• Paragraph Style—Affects the look of an entire paragraph and uses the following 
indicator in the Styles Pane (¶). 

• Character Style—Affects the look of selected text within a paragraph and uses the 
following indicator in the Styles Pane (a). 

• Linked Style—Affects the look of an entire paragraph or selected text within a paragraph. 
This type of MS Word style acts as both a paragraph and character style and uses the 
following indicator in the Styles Pane. (¶a) 

• List Style—Affects the look of bulleted and numbered lists. 

• Figure Styles—Affects the look and layout of figure titles and captions 

• Table Styles—Affects the look and layout of a table. 

Note: Appendix B shows a full list of styles defined in the NYSERDA Report Template.  

Heading Styles 
The NYSERDA Report Template has a pre-defined set of heading styles to apply to different 
parts of the document for format consistency throughout the report. Applying heading levels  
to a report ensures the section headings and subheadings appear in the Table of Contents  
and helps readers who need to navigate the report pages using assistive technology. 

The Front Matter sections (before the main report body), such as Notice and Abstract, use 
unnumbered headings (i.e., Heading 1 No Number). 

In the main body of the report, the Main Topic heading of each section uses numbered 
Heading 1 style. Subtopic headings use Heading 2 through Heading 4 styles. Headings should 
not be stacked; instead, it is recommended to include text beneath each heading. Even adding 
one or two introductory sentences is helpful. 
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Note: The Heading 5 style is an unnumbered style that may be used sparingly if content under 
Heading 4 requires additional separation. Heading styles must be applied in a logical sequence, 
you cannot jump from a level 2 heading to a level 4 or 5 heading without using level 3 headings 
first. Do not apply heading styles beyond Heading 5. (Heading 7 through 9 styles are reserved 
for Appendix-related headings.) 

Body Text Style 
Most paragraphs of text in a report use the “Body Text” style. In the NYSERDA Report Template, 
the gray text fields already have Body Text style applied; click in a gray text field to start typing. 

Furthermore, if the body text prefaces a bulleted or numbered list, use the “Body Text (before a 
list)” style. 

Bulleted List and Numbered List Styles 
The following styles are used to format text as bullet or numbered lists. 

• This is List Bullet style. 

1. This is List Number style. 

This is List Continue style to use when there is a need for unnumbered text after a list 
number item. 

2. This is List Number style. 

○ This is List Bullet 2 style. 

This is List Continue 2 style to use when there is a need for unbulleted text after a list 
bullet item. 

To restart a numbered list, right-click the numbered list item and select Restart at 1. 

1. This is List Number restarted at 1. 

2. This is List Number style. 

○ This is List Bullet 2 style. 

■ This is List Bullet 3 style. 
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Other Commonly Used Styles 
Note: Highlighting and using the Bold (B) or Italics (I) buttons on the MS Ribbon are not 
effective in creating accessibility tags; instead, use the Strong or Emphasis character styles to 
modify text. 

• Emphasis: Character styles for italicizing (Emphasis) selected text. 

• Strong: Character styles for bolding (Strong) selected text. 

• Hyperlink: Character style for underlining text with hyperlinks. 

Applying Template Styles 
Use the Quick Styles Gallery or the Styles Pane to apply styles to different pieces of content in 
the report. 

Applying Styles with the Quick Styles Gallery 
The Quick Styles gallery is set up to show the most used styles in the NYSERDA Report template. 
It’s easier and faster to apply styles this way. 

To apply styles using the Quick Styles gallery: 

1. Select the content (text or paragraph) where you want to apply a style. 

2. From the MS Word Home tab, click the Quick Styles Gallery drop-down list. 

 

3. In the Quick Styles gallery, click the applicable style to apply. 

The selected content changes to match the applied style. 
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Applying Styles with the Styles Pane 
The Styles pane shows all the styles that are available for use in the template. Use the Styles 
pane instead of the Quick Styles gallery if you want access to all the styles or when you want to 
apply a style that isn't used very often. 

To apply paragraph or character styles using the Styles pane: 

1. From the MS Word Home tab, click the Styles Pane drop-down list. 

 

 

The Styles pane shows on the left or right side of the screen, depending on how 
MS Word is configured. The pane can be moved around (floating) or docked for 
convenience. 

Note: To preview how each style looks, select the Show Preview check box on the Styles pane. 

2. Select the content where you want to apply a style. 

3. In the Styles pane, click the style to apply. 

4. The selected content changes to match the applied style. 
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TIP: When applying paragraph styles (¶), you don’t need to select the entire paragraph. Simply 
place the cursor within the paragraph and select the style. The style will apply from the 
beginning of the paragraph to the next hard return (¶). Character styles (a) require content 
selection prior to being applied. When applying styles to selected content, any intentional 
content modifications (sub script, super script, italic, etc.) will be overridden by the new style 

Viewing Applied Styles 
One of the easiest ways to quickly see what style is currently applied to text in your report 
document is to click on the text and then press Ctrl + Shift + S. 

 

Using this feature helps to figure out what styles to apply to new content or content pasted 
from an external source that has to be reformatted to use the NYSERDA Report template styles. 
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Working with Figures, Equations, and Tables 
This section contains example document elements such as figures, tables, and equations as well 
as figure/equation/table titles that are already configured with the proper auto-numbered fields. 
To keep the format of the document consistent, you should copy an example element set from 
this section and paste it where you want it in the document. Then, make any necessary changes 
to the content. 

TIP: Keep this section in your report document until the writing phase is complete so that you 
can copy and paste sample elements as needed. Delete the sample content in the template 
when it is no longer needed. 

For example, in Figure 1, copy the example figure title, figure caption description, figure source, 
and the figure itself, then paste in the desired insertion point in the document and change the 
text and figure accordingly. Doing so keeps you from having to reapply styles every time you 
need to add a figure or table to the report. 

This sentence provides an example of an inserted endnote or footnote so that the 
accompanying example text shows at the end of the document for footnotes, and the  
end of the page for footnotes.1  

TIP: To update the numbering of all auto-numbered fields in a report document, press Ctrl + A 
to select entire document, then press F9 to update all sequential field entries (i.e., figure, table, 
and equation titles, TOC, LOF, LOT, cross-references, etc.). The auto-numbered fields will update 
to the correct sequential number. 

Example Figure-Related Styles 
Figures with sequential numbering Figure 1, Figure 2, etc. are preferred. Use in-text cross-
references to figures with only the figure label and number (i.e., Figure 1 shows). Additionally, 
provide Alternative Text to comply with ADA Accessibility requirements. Refer to ADA Section 
508 Standards for the best way to represent data with reference to colors. 

Copy and paste the below figure set where needed in the report and then modify the figure 
caption title, figure caption description, source, and the figure itself as needed. This helps ensure 
the correct styles are used for all figure elements. 

 
1 This is what the Footnote Text style looks like when a footnote is used in the report. A footnote displays at the end 

of the page for the applicable footnote citation. 

https://www.section508.gov/create/documents/
https://www.section508.gov/create/documents/
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Figures should not have borders unless the figure is not easily distinguishable from the 
surrounding text. If a border is used, apply the following settings: 

 

• Picture Border Color: White Background 1, Darker 15% 

• Picture Border Line Weight: 3/4 pt 

Note: Figure caption descriptions and are preferred but not mandatory for each figure. Figure 
source information is required any time the figure was created for a different document and 
reproduced in the current document.  

Figure 1. Sample Photo Figure 

This is the figure caption description used to provide additional context for a figure. The figure example below 
has the Figure Anchor style applied, which provides more above and below space and left-aligns the figure. 
Apply the Figure Anchor style to any figures added to the report, including photos, charts, illustrations, etc. 

Source: State University (2024) 
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Figure 2. Sample Chart Figure 

This is the figure caption description used to provide additional context for a figure. Before publishing, ensure 
chart-like figures are added to the report as flattened images (all layers and sub components combined into a 
single ‘flat” image). Figures need to be legible and include legends within the figure as necessary. 

Source: Name (Date) 

 

Adding Alternative Text to a Figure 
Alt text gives photos, graphs, charts, and other non-text figures clear, descriptive alternate text 
(alt text). Users with visual accessibility needs can utilize screen readers to see. Be sure to 
provide meaningful alt text that describes the figure completely. Visit NYSERDA’s website for 
additional accessibility resources.  

Alternative Text (Alt text) is a federal and State requirement for making documents accessible to 
individuals using assistive technology to read the document. It must be added to all images, 
figures, diagrams, charts, etc. 

To Add Alt Text to Figures: 

5. Hover over image, right click, select View alt text from the menu.  

6. An “Alt text” box will appear on the right side of the document.  

7. Type a description into the box that adequately describes the visual. 

https://www.nyserda.ny.gov/About/Doing-Business-with-NYSERDA
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Example Equations 
The NYSERDA Report template has equations and formulas centered on the page, with the 
equation sequence number included as an equation title on the same line and left aligned. New 
equations can be created by copying and pasting the below example Equation 1, then and 
customizing it in the new location. 

Note: Ensure that the equation is not bold. Screen readers will read the bold, which can interfere 
with the equation flow. 

Equation 1. 𝑎𝑎2 + 𝑏𝑏2 = 𝑐𝑐2  

If an equation or formula requires elements be defined, show the information in the following 
manner: 

Equation 2. 𝐴𝐴 = 𝜋𝜋𝑟𝑟2  

where: 

• A = the area of the circle 

• π (pi) = is a mathematical constant, approximately equal to 3.14159. 

• R = the radius of the circle 

Example Tables 
The tables used in NYSERDA reports are created with MS Word’s built-in Table Grid style. 
Furthermore, the table header row is shaded a light blue color (RGB: 239, 246, 351 or  
Hex: #EFF6FB). The content in the tables have styles applied related to table text.  

The example tables in the template and this document are simple and designed with ADA 
Section 508 Accessibility requirements in mind. The tables have only one table header row and 
no merged cells. Additionally, the table properties for each table are already set to “Repeat 
Header Row” and “Do not allow rows to break across pages.” 

See also: Section 508 Accessibility Standards. 

Copy and paste one of the sample table sets, then modify the table caption title, table caption 
description, table source, and the table itself, as needed. Each table requires its own table title, 
and uses automated, sequential table number fields (e.g., Table 1, Table 2, etc.). 

  

https://www.section508.gov/create/documents/
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Note: Table caption descriptions and are preferred but not mandatory for each table. table 
source information is required any time the table was created for a different document and 
reproduced in the current document. 

Table 1. Sample Table Showing Table-Related Styles 

This is the optional table caption description used to provide additional context for a table. This is the optional 
table caption description used to provide additional context for a table. 

Source: Name (Date) 

Table Heading Center Table Heading Center Table Heading Center Table Heading Center 
Table Text Left 
• Table Bullet 
• Table Bullet 

Table Text Center Table Text Center Table Text Right 

Table Text Left Table Text Center Table Text Center Table Text Right 
1. Table List Number 
2. Table List Number 
3. Table List Number 

Table Text Center Table Text Center Table Text Right 

Table Text Left Table Text Center Table Text Center Table Text Right 
 

Tables Spanning Multiple Pages 
If a table spans across multiple pages, it is important for each page to show the table number so 
that the reader knows exactly which table they are viewing. To display the table number at the 
top of each continued page, separate the table into two or more tables as needed. 

For each continued table, add a table header row and then copy and paste the following sample 
“table continued” title, which is set up to duplicate the table number from the previous page. 

Table 1. (continued) 

Table Heading Center Table Heading Center Table Heading Center Table Heading Center 
Table Text Center Table Text Center Table Text Center Table Text Right 
Table Text Center Table Text Center Table Text Center — 
Table Text Center Table Text Center Table Text Center — 

End of table. 

Note: When a table needs to be continued on a new page, manually type the same table title 
number from the previous page. This way, the number shown in the “Table # (continued)” title 
matches the previous table.  
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Table Notes 
When table data requires additional explanatory information in the form of table notes, add a 
superscript letter at the end of the data. Under the table, apply the “Table Note” style to each 
note added. The Table Notes style is designed to change the appearance of table note text and 
applies alphabetic auto-numbering to each note as shown in the example Table 2. 

Table 2. Sample Table with Table Notes 

This is an optional table caption description used to provide additional context for a table. The table caption 
description can also be used to add a general note that applies to the entire table. This is in contrast to using a 
superscript letter in combination with a Table Note (below) when a note applies only to specific content within 
a table. 

Source: Name (Date) 

Year Weather Event Population Affected 
1950a Rain 35,000 
1980 Hurricane 83,000 
2010 Derecho 116,000 
2030 Tornado See noteb. 

a. This is an optional Table Note style used to provide additional context for superscripted “a” in the table content. 
b. This is an optional Table Note style used to provide additional context for superscripted “b” in the table content. 

Adding Alternative Text to a Table 
Alternative text (Alt text) enables screen readers and other accessibility tools to recognize and 
read aloud tabular content for users with visual accessibility needs. Write descriptive, easy to 
read alt text for each table. 

Note: Some accessibility checkers do not show alerts if a table is missing alt text. However, 
contrary to previous directives from NYSERDA, processes have changed with the updated 
Section 508 requirements, and now require alt text for tables in NYSERDA documents.  

To add alt text to a table: 

1. Right-click on the desired table and select Table Properties. 

The Table Properties dialog box is displayed. 

2. Click the Alt Text tab  
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3. In the Title field, type a brief, concise title for the table.  

4. In the Description field, type a more detailed description of the table’s purpose  
and content. 

5. Click OK to save. 

Color Usage in Figures and Tables 
NYSERDA follows New York State Brand Guidelines, which creates consistencies across all  
State agencies and authorities.2 The NYSERDA Marketing team has the following general 
recommendations for use of colors in figures, charts, and graphs created for NYSERDA reports: 

• Use high-contrast colors, legible text size, adequate negative space, and simple visual 
elements to convey a message. 

 
2 New York State Brand Guide (2024). 
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• When possible, use the brand colors specified by NYSERDA. 

• Use the following approved colors when creating figures for NYSERDA reports. 

Note: The approved colors are for figures only. Do not use when creating tables. 

Color  Hex Code  
  #168D3C  

  #0B5583  

  #780000  

  #B94F4F  

  #DB6E00  

  #8A4602  

  #000000  

  #7D7D7D  

  #8B7FA0  

  #0091FF  

 

Record of Revision 
A record of revision documents changes made to a published document, detailing when the 
modifications occurred, what was altered, and on which page the changes are found. The record 
of Revision is required when changes are made to a previously published document, or when a 
serial publication is updated (quarterly reports, or annual reports providing status updates).  

The Record of Revision should appear before the title page, and should be numbered as roman 
numeral i.  Use Heading 1 No Number style for the title, and appropriate table styles for the 
body.  
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Record of Revision (Heading 1 No Number) 

Document Title (Table Heading Center) 

Add Document Title Here (Table Text Center) 
Add Month and Year of Publication/Filing (Table Text Center) 

 

Revision Date Description of Changes (Table Heading Left) Revision on Page(s) 

Add Date Original Issue (Table Text Center) Original Issue 

   

   

   

   

   

   

   

   

   

   

   
 

Example Sidebars 
A sidebar is a short topic description that is relevant to the main text but not part of the 
immediate content flow. Copy and paste this example sidebar where you want to use it in the 
document and then modify the heading and text. 
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Note: you cannot format text around images within sidebars. All images will remain inline.  

 

Sidebar Topic Heading (half-page 
width) 

A sidebar is a short topic description that is 
relevant to the main text but not part of the 
immediate content flow. Copy and paste this 
example sidebar where you want to use it in the 

        

Sidebar Topic Heading (full-page width) 

A sidebar is a short topic description that is relevant to the main text but not part of the immediate 
content flow. Copy and paste this example sidebar where you want to use it in the document and then 
modify the heading and text. 
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Working with Footnotes and Endnotes 
Footnotes and endnotes have a numbered citation in superscript at the end of the referenced 
text, and a linked information statement at the bottom of the referenced page (for footnotes) or 
at the end of the document (for endnotes). 

 

Endnotes are preferred when the footnotes at the bottom of a page extend beyond three or 
four lines of text. 

To insert a footnote: 

1. Click at the end of the reference citation to which you want to add a footnote reference. 

2. Click References > Insert Footnote. 

MS Word inserts a footnote reference indicator and takes you to the footnote area near 
the bottom of the page to add more detailed information for the numbered footnote 
reference. 

Note: To insert a footnote using a keyboard shortcut, press Ctrl + Alt + F. 

To insert an endnote: 

1. Click at the end of the reference citation to which you want to add an endnote reference. 

2. Click References > Insert Endnote. 

MS Word inserts an endnote reference indicator and takes you to the endnote area at 
the end of the document to add more detailed citation information for the numbered 
endnote reference. 

Note: To insert an endnote using a keyboard shortcut, press Ctrl + Alt + D. 

To convert footnotes to endnotes: 

1. Select the References tab. 

2. Open the Footnote/Endnote Dialog Box (click the small square in the bottom-right 
corner of the tab). 
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3. Select Footnotes. 

 

4. Click Convert. 

 

5. Select Convert all footnotes to endnotes, the click OK. 
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Working with Citations and References 
A References section is provided in the NYSERDA report template to add complete citations of 
cited works. NYSERDA’s citation style is based on the Chicago Manual of Style (18th edition) and 
its Notes and Bibliography system as well as Marketing preferences. For more information, 
consult the Chicago Manual Online: Chicago-Style Citation Quick Guide under the Notes and 
Bibliography tab). 

Note: See the example References list and the example Endnotes list in the NYSERDA Report 
template. 

Cross-References 
In-text cross-references to figures and tables need to show only the label and number (e.g., 
Figure 2, Table 1). 

To insert a cross-reference for a figure, equation, or table: 

1. Click Insert > Reference > Cross-Reference. 

2. Do one of the following: 

○ For a figure cross reference, select Figure as the reference type and insert reference 
as Only label and number. 

○ For a table cross reference, select Table as the reference type and insert reference as 
Only label and number. 

○ For an equation cross reference, select Equation as the reference type and insert 
reference as Only label and number. 

 

https://www.chicagomanualofstyle.org/tools_citationguide.html
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3. Select the corresponding figure, table, or equation you want to cross-reference  
from the list. 

4. The resulting cross-reference shows in the document like the following examples: 

○ As shown in Figure 2 

○ Table A-1 contains a list of styles 

○ The calculation in Equation 1 is used to determine 

References List 
A formal acknowledgement is required for sources used in the report. These citations  
require inline author-year references and also a full citation in the reference list. Sources used to 
develop the content of the document, but are not cited for specific concepts or text should 
contain a full citation in the Other References section. In line citations are not required for  
this list. 

Last Name, First Name. YYYY. Title. Source. 

Microsoft. “Make your Word documents accessible to people with disabilities.” Accessed August 
10, 2025. https://support.microsoft.com/en-us/office/make-your-word-documents-
accessible-to-people-with-disabilities-d9bf3683-87ac-47ea-b91a-
78dcacb3c66d#bkmk_textspacing_win 

New York State Climate Action Council. 2022. New York State Climate Action Council Scoping 
Plan. www.climate.ny.gov/ScopingPlan 

Organization Name. YYYY. Publication Title. Source. 

State University. “All About Tornado Energy at State University.” Accessed November 12, 2024. 
https://www.stateuniv.edu/all-about-energy. 

Organization. "Website Page Title." Accessed [Date]. URL. 

https://www.stateuniv.edu/all-about-energy
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Submitting a Report to NYSERDA 
The information in this section is designed to assist contractors in submitting reports to 
NYSERDA. 

Report Submission Overview for Third-Party Contractors 
Before submitting a report to NYSERDA, review the “Quick Checklist for Report Writers and 
Preparers” to ensure the report meets NYSERDA’s defined standards and guidelines. 

When a report is ready for submission, email an electronic MS Word version of the draft report 
to the assigned NYSERDA project manager. The report must be an MS Word document with a 
“.doc” or “.docx” file format. Print drafts are not required. 

Note: Do not submit an MS Word document that was converted from PDF format. Converting a 
document from PDF to MS Word introduces numerous formatting changes and oddities that 
make the document very difficult to work with effectively. 

The contractor is responsible for addressing comments from NYSERDA and other stakeholders. 
When making corrections, the contractor must ensure that technical content is not 
compromised. After editorial corrections are made, the contractor must convert the report to 
pdf and ensure that the report meets accessibility standards are met. Both the Word document 
and the pdf should be emailed to the project manager.  

NYSERDA’s project manager is responsible for publishing the finished report online and/or in 
print format unless there are special circumstances. Direct questions about technical content 
and submission deadlines to the assigned NYSERDA project manager. For any questions related 
to report formatting and electronic submissions, contact NYSERDA Marketing at 
print@nyserda.ny.gov. 

Important Contact Information: 

• The NYSERDA project manager should be the contractor’s primary point of contact. 

• For additional questions, contact NYSERDA’s marketing department at 
print@nyserda.ny.gov. 

 

mailto:print@nyserda.ny.gov
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Appendix A. Word Shortcuts 
The following are some commonly used keyboard shortcuts to help you work more efficiently in 
MS Word. 

Task Shortcut 
Heading 1 style. Ctrl+Alt+1 
Heading 2 style. Ctrl+Alt+2 
Heading 3 style. Ctrl+Alt+3 
Body Text style Ctrl+Alt+B 
List Bullet style Alt+Q 
List Number style  Alt+N 
Table Heading Center style Alt+H 
Table Text Center style Alt+T 
Display the Apply Styles task pane. Ctrl+Shift+S 
Display the Styles task pane. Ctrl+Alt+Shift+S 
Cut the selected content to the Clipboard. Ctrl+X 
Copy the selected content to the Clipboard. Ctrl+C 
Paste the contents of the Clipboard. Ctrl+V 
Switch the text between upper case, lower case, 
and title case. 

Shift+F3 

Remove manual character formatting. Ctrl+Spacebar 
Apply superscript formatting. Ctrl+Shift+Plus sign (+) 
Insert a page break. Ctrl+Enter 
Insert an em dash (—). Ctrl+Alt+Minus sign (on the numeric keypad) 
Insert an en dash (–). Ctrl+Minus sign (on the numeric keypad) 
Insert a registered trademark symbol (®). Ctrl+Alt+R 
Insert a trademark symbol (™). Ctrl+Alt+T 
Update field codes (TOC, cross-references.) Select desired text and press F9. 
Turn change tracking on or off. Ctrl+Shift+E 
Insert a footnote. Ctrl+Alt+F 
Insert an endnote. Ctrl+Alt+D 
Insert a trademark symbol ™ Ctrl+Alt+T 

 

Additional MS Word shortcuts are available on the Microsoft Support Keyboard Shortcuts page. 

 

https://support.microsoft.com/en-us/office/keyboard-shortcuts-in-word-95ef89dd-7142-4b50-afb2-f762f663ceb2
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Appendix B. List of Styles Available in the 
NYSERDA Report Template 
The NYSERDA Report Template contains the following styles that can be applied to text in a 
report document. Some styles do not show in this list because they were used only for the 
template creation process and should not be applied to report content. 

Note: The template has examples of most of the styles necessary to create a report. We 
recommend copying and pasting content from the template, then modifying the text to ensure 
the correct styles are used. However, advanced users of Word may find it easier to apply styles 
as they write. 

Style Name Description/Usage 
Acronyms Used to format content listed in the Acronyms section. 
Block Text Used to show italicized text centered on page with increased left 

and right margins. 
Body Text Used for main text in all sections, subsections, and appendices. 
Body Text (before a list) Used for main text immediately before a bulleted or numbered 

list in all sections, subsections, and appendices. 
Default Paragraph Font Used to remove any manual formatting on selected text. 
Emphasis Used to show selected text in italics. 
Endnote Reference Used to format the endnote reference number. 
Endnote Text Used to format the endnote text. 
Equation Used to format an inserted equation. 
Equation Title Used for the shortened figure caption and to automatically 

number equations in a document. 
Figure Anchor (or Figure Placement) Used to apply to a figure to replace any other formatting and 

center the figure on the page. 
Figure Caption Description Used to provide a longer figure caption that shows under the 

figure title. 
Figure Source Used to show the credited source for a figure. 
Figure Title Used for the shortened figure caption that shows in the List of 

Figures and to automatically number figures in a document. 
Footnote Reference Used to format the footnote reference number. 
Footnote Text Used to format the footnote text. 
Glossary Used to format content listed in the Definitions or Glossary 

section. 
Heading 1 Used to format each major numbered section heading and uses 

an outline numbering style (e.g., 1.0 Introduction). Heading 1 
style has an automatic page break before the Heading. Heading 
1 shows in the Table of Contents. 
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Style Name Description/Usage 
Heading 1 No Number Similar to Heading 1 but without outline numbering and there is 

no automatic page break before the heading. 
Heading 2 through Heading 6 Used to format each additional numbered subsection heading 

and uses an outline numbering style (e.g., 1.1, 1.1., etc.). 
Headings 1 through 3 show in the Table of Contents. 

Heading 2 No Number through 
Heading 6 No Number 

Similar to Headings 2 through 6 but without outline numbering. 

Heading 7 (Appendix A) Used to format each major Appendix heading and uses an 
outline alpha-numbering style (e.g., Appendix A. Word 
Shortcuts). 

Heading 8 (Appendix A.1) Used to format each Appendix subheading and uses an outline 
alpha-numbering style (e.g., Appendix A.1). 

Heading 9 (Appendix A.1.1) Used to format each Appendix subheading and uses an outline 
alpha-numbering style (e.g., Appendix A.1.1). 

Hyperlink Used by MS Word when a hyperlink is inserted or applied 
manually to selected text. 

List Bullet, List Bullet 2, List Bullet 3 Used to create a bulleted list. The first level uses ●; the second 
level uses ○, the third level uses ‒, and the fourth level uses ■. 

List Continue, List Continue 2,  
List Continue 3 

Used to show additional text under a list bullet or list number 
that aligns correctly with the list. 

List Number, List Number 2,  
List Number 2 

Used to create a numbered list. 

Note Used to add an informational note. The note is outlined with a 
light-gray border. 

References List Used to format and number the full reference citations in the 
References section. 

Strong Used to show selected text in bold. 
Table Anchor Used to format an insertion point for a table. (optional) 
Table Bullets Used to add a bulleted list (●) within a table. 
Table Caption Description Used to provide a longer table caption that shows under the 

table title. 
Table Heading Center Used to format table header text. Centers the header text. 
Table Heading Left Used to format table header text. Left-aligns the header text. 
Table Heading Right Used to format table header text. Right-aligns the header text. 
Table Last Row Used to add additional space beneath a table. 
Table List Number Used to create a numbered list with a table. 
Table Note Style used for notes related to content in a table; the alpha-

numbered notes appear beneath the table. 
Table Source Used to show the credited source for data in a table. 
Table Text Center Used to format text within a table. Centers the text. 
Table Text Left Used to format text within a table. Left-aligns the text. 
Table Text Right Used to format text within a table. Right-aligns the text. 
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Style Name Description/Usage 
Table Title Used for the shortened table caption that shows in the List of 

Tables and to automatically number tables in a document. 
Title Page-Location Used on Title Page only. 
Title Page-Name & Title Used on Title Page only. 
Title Page-Organization Used on Title Page only. 
Title Page-Project Details Used on Title Page only. 
Title Page-Project Heading Used on Title Page only. 
Subtitle,Title Page-Sections Used on Title Page only. 
TOC 1, TOC 2, TOC 3 Used by MS Word to automatically generate the Table of 

Contents. 
TOC Heading Used to format the Table of Content heading. 
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Appendix C. Best Practices to Make Word 
Documents Accessible 
The following information describes common guidelines to follow for making reports accessible 
to people using assistive technologies. This information is taken from the Microsoft Support 
website:3 

What to fix How to find it Why fix it How to fix it 
Use the built-in 
headings and 
styles from the 
template. 

To check that the order of 
headings is logical, visually 
scan your document's table 
of contents. 

To preserve tab order and to 
make it easier for screen 
readers to read your 
documents, use a logical 
heading order and the built-in 
formatting tools in Word. 
You can also use paragraph 
banners to organize your 
content. 

Use built-in title, subtitle, 
and heading styles 
Create accessible lists 
Adjust space between 
sentences and 
paragraphs 
Create paragraph banners 

Avoid common 
accessibility issues 
such as missing 
alternative text 
(alt text) and low 
contrast colors. 

Use the Accessibility 
Checker. 

Make it easy for everyone to 
read your documents. 

Check accessibility while 
you work in Word 

Include alt text 
with all visuals. 

To find missing alt text, use 
the Accessibility Checker. 

Alt text helps people who can’t 
see the screen to understand 
what’s important in images 
and other visuals. 

Add alt text to visuals 

Use a simple table 
structure for data 
only, and specify 
table column 
headings. 

To ensure that tables don't 
contain split cells, merged 
cells, or nested tables, use 
the Accessibility Checker. 
Visually scan your tables to 
check that they don't have 
any completely blank rows 
or columns. 

Screen readers keep track of 
their location in a table by 
counting table cells. If a table is 
nested within another table or 
if a cell is merged or split, the 
screen reader loses count and 
can’t provide helpful 
information about the table 
after that point. Blank cells in a 
table could also mislead 
someone using a screen reader 
into thinking that there is 
nothing more in the table. 

Avoid using tables 
Use table headers 
Use built-in title, subtitle, 
and heading styles 
Create paragraph banners 

 
3 Make your Word documents accessible to people with disabilities. https://support.microsoft.com/en-

us/office/make-your-word-documents-accessible-to-people-with-disabilities-d9bf3683-87ac-47ea-b91a-
78dcacb3c66d#bkmk_textspacing_win 

https://support.microsoft.com/en-us/office/make-your-word-documents-accessible-to-people-with-disabilities-d9bf3683-87ac-47ea-b91a-78dcacb3c66d#bkmk_builtinheadings_win
https://support.microsoft.com/en-us/office/make-your-word-documents-accessible-to-people-with-disabilities-d9bf3683-87ac-47ea-b91a-78dcacb3c66d#bkmk_builtinheadings_win
https://support.microsoft.com/en-us/office/make-your-word-documents-accessible-to-people-with-disabilities-d9bf3683-87ac-47ea-b91a-78dcacb3c66d#bkmk_createlists_win
https://support.microsoft.com/en-us/office/make-your-word-documents-accessible-to-people-with-disabilities-d9bf3683-87ac-47ea-b91a-78dcacb3c66d#bkmk_textspacing_win
https://support.microsoft.com/en-us/office/make-your-word-documents-accessible-to-people-with-disabilities-d9bf3683-87ac-47ea-b91a-78dcacb3c66d#bkmk_textspacing_win
https://support.microsoft.com/en-us/office/make-your-word-documents-accessible-to-people-with-disabilities-d9bf3683-87ac-47ea-b91a-78dcacb3c66d#bkmk_textspacing_win
https://support.microsoft.com/en-us/office/make-your-word-documents-accessible-to-people-with-disabilities-d9bf3683-87ac-47ea-b91a-78dcacb3c66d#bkmk_parabanners_win
https://support.microsoft.com/en-us/office/improve-accessibility-with-the-accessibility-checker-a16f6de0-2f39-4a2b-8bd8-5ad801426c7f#PickTab=Windows
https://support.microsoft.com/en-us/office/improve-accessibility-with-the-accessibility-checker-a16f6de0-2f39-4a2b-8bd8-5ad801426c7f#PickTab=Windows
https://support.microsoft.com/en-us/office/make-your-word-documents-accessible-to-people-with-disabilities-d9bf3683-87ac-47ea-b91a-78dcacb3c66d#bkmk_whileyouwork_win
https://support.microsoft.com/en-us/office/make-your-word-documents-accessible-to-people-with-disabilities-d9bf3683-87ac-47ea-b91a-78dcacb3c66d#bkmk_whileyouwork_win
https://support.microsoft.com/en-us/office/improve-accessibility-with-the-accessibility-checker-a16f6de0-2f39-4a2b-8bd8-5ad801426c7f#PickTab=Windows
https://support.microsoft.com/en-us/office/make-your-word-documents-accessible-to-people-with-disabilities-d9bf3683-87ac-47ea-b91a-78dcacb3c66d#bkmk_altvisuals_win
https://support.microsoft.com/en-us/office/improve-accessibility-with-the-accessibility-checker-a16f6de0-2f39-4a2b-8bd8-5ad801426c7f#PickTab=Windows
https://support.microsoft.com/en-us/office/make-your-word-documents-accessible-to-people-with-disabilities-d9bf3683-87ac-47ea-b91a-78dcacb3c66d#bkmk_avoid_tables_win
https://support.microsoft.com/en-us/office/make-your-word-documents-accessible-to-people-with-disabilities-d9bf3683-87ac-47ea-b91a-78dcacb3c66d#bkmk_tableheaders_win
https://support.microsoft.com/en-us/office/make-your-word-documents-accessible-to-people-with-disabilities-d9bf3683-87ac-47ea-b91a-78dcacb3c66d#bkmk_builtinheadings_win
https://support.microsoft.com/en-us/office/make-your-word-documents-accessible-to-people-with-disabilities-d9bf3683-87ac-47ea-b91a-78dcacb3c66d#bkmk_builtinheadings_win
https://support.microsoft.com/en-us/office/make-your-word-documents-accessible-to-people-with-disabilities-d9bf3683-87ac-47ea-b91a-78dcacb3c66d#bkmk_parabanners_win
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What to fix How to find it Why fix it How to fix it 
Add meaningful 
hyperlink text and 
ScreenTips. 

To determine whether 
hyperlink text makes sense 
as standalone information 
and whether it gives 
readers accurate 
information about the 
destination target, visually 
scan your document. 

People who use screen readers 
sometimes scan a list of links. 

Add accessible hyperlink 
text and ScreenTips 

Ensure that color 
is not the only 
means of 
conveying 
information. 

To find instances of color-
coding, visually scan your 
document. 

People who are blind, have low 
vision, or are colorblind might 
miss out on the meaning 
conveyed by particular colors. 

Use accessible font 
format 

Use sufficient 
contrast for text 
and background 
colors. 

To find insufficient color 
contrast, use 
the Accessibility Checker. 
You can also look for text 
in your document that’s 
hard to read or to 
distinguish from the 
background. 

If your document has a high 
level of contrast between text 
and background, more people 
can see and use the content. 

Use accessible font color 

Avoid writing 
important 
information in the 
Header or Footer 
areas of the 
document. 

Headers and Footers are 
visible only in the Print 
Layout view and the Print 
Preview. 
Double-click the Header or 
the Footer to activate and 
edit its content. 

People who use screen readers 
miss out on important 
information as screen readers 
do not scan Headers or 
Footers. 

Use built-in heading 
styles in the main body of 
the document. 
Include any redundant 
information in the 
Header or Footer section. 

 

https://support.microsoft.com/en-us/office/make-your-word-documents-accessible-to-people-with-disabilities-d9bf3683-87ac-47ea-b91a-78dcacb3c66d#bkmk_links_and_screentips_win
https://support.microsoft.com/en-us/office/make-your-word-documents-accessible-to-people-with-disabilities-d9bf3683-87ac-47ea-b91a-78dcacb3c66d#bkmk_links_and_screentips_win
https://support.microsoft.com/en-us/office/make-your-word-documents-accessible-to-people-with-disabilities-d9bf3683-87ac-47ea-b91a-78dcacb3c66d#bkmk_fontformat_win
https://support.microsoft.com/en-us/office/make-your-word-documents-accessible-to-people-with-disabilities-d9bf3683-87ac-47ea-b91a-78dcacb3c66d#bkmk_fontformat_win
https://support.microsoft.com/en-us/office/improve-accessibility-with-the-accessibility-checker-a16f6de0-2f39-4a2b-8bd8-5ad801426c7f#PickTab=Windows
https://support.microsoft.com/en-us/office/make-your-word-documents-accessible-to-people-with-disabilities-d9bf3683-87ac-47ea-b91a-78dcacb3c66d#bkmk_fontcolor_win
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